RADIO MUSEUM HANDBOOK

User and Administrator Guidelines

English Version 0.013

July 22, 2018

Preliminary Draft
## Revision History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Who</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.001</td>
<td>Jan 25, 2015</td>
<td>John Kusching</td>
<td>Initial Draft</td>
</tr>
<tr>
<td>0.002</td>
<td>Feb 1, 2015</td>
<td>John Kusching</td>
<td>Incorporated suggested changes from Gidi Verheijen. Added section on how to download a schematic. Added Voltage field definition in new model proposal section. Reduced picture file sizes in upload price information section. Added new subsection titles to Model Admin section.</td>
</tr>
<tr>
<td>0.003</td>
<td>Feb 10, 2015</td>
<td>John Kusching</td>
<td>Added section on classifying homebrew sets. Added Administrator section on how to handle Duplicate (Doublet) model pages.</td>
</tr>
<tr>
<td>0.004</td>
<td>March 28, 2015</td>
<td>John Kusching</td>
<td>Added lineup tube section.</td>
</tr>
<tr>
<td>0.005</td>
<td>August 24, 2016</td>
<td>John Kusching</td>
<td>Added “or.” Alternate Semiconductor Rule in tube lineup section.</td>
</tr>
<tr>
<td>0.006</td>
<td>June 3, 2017</td>
<td>John Kusching</td>
<td>Added AF stage and Number of AM and FM circuits definition sections.</td>
</tr>
<tr>
<td>0.007</td>
<td>October 19, 2017</td>
<td>John Kusching</td>
<td>Added procedure to modify prices (For “Collectorprice-Admins”)</td>
</tr>
<tr>
<td>0.008</td>
<td>November 15, 2017</td>
<td>John Kusching</td>
<td>Added procedure to correct schematic finder reference.</td>
</tr>
<tr>
<td>0.009</td>
<td>Dec 2, 2017</td>
<td>John Kusching</td>
<td>Added additional information to correct schematic finder reference.</td>
</tr>
<tr>
<td>0.010</td>
<td>Dec 10, 2017</td>
<td>John Kusching</td>
<td>Added notes on waveband fields.</td>
</tr>
<tr>
<td>0.011</td>
<td>Dec 17, 2017</td>
<td>John Kusching</td>
<td>Added “Auto Login” section.</td>
</tr>
<tr>
<td>0.012</td>
<td>February 18, 2018</td>
<td>John Kusching</td>
<td>Added Schematic Formatting procedure</td>
</tr>
<tr>
<td>0.013</td>
<td>July 22, 2018</td>
<td>John Kusching</td>
<td>Added example of “or” and “or.” use in valves/tubes &amp; semiconductor lineup</td>
</tr>
</tbody>
</table>
# Table of Contents

Revision History ....................................................................................................................... ii

Table of Contents ....................................................................................................................... iii

List of Figures ............................................................................................................................. vi

1 Introduction ............................................................................................................................. 1
   1.1 Description ......................................................................................................................... 1
   1.2 Radio Museum Goals ......................................................................................................... 1

2 General Information ............................................................................................................... 2
   2.1 Enabling the “Automatic Login” Feature ........................................................................... 2

3 How to upload pricing information ....................................................................................... 3
   3.1 Uploading a radio price to Radio Museum ...................................................................... 3
      3.1.1 FIND PRICING INFORMATION IN FINISHED AUCTIONS ON EBAY .................. 3
      3.1.2 GO TO THE MODEL PAGE WHERE THE PRICE IS TO BE LOADED .................. 6

4 How to format a picture ......................................................................................................... 9
   4.1 Formatting a picture using Irfanview ............................................................................... 9
      4.1.1 CROP THE PICTURE .......................................................................................... 10
      4.1.2 ADJUST DIMENSIONS OF THE PICTURE ......................................................... 14
      4.1.3 SAVING THE PICTURE FILE ........................................................................... 17

5 How to upload a picture ......................................................................................................... 20
   5.1 Uploading a picture to Radio Museum .......................................................................... 20
      5.1.1 GO TO MODEL PAGE WHERE PICTURE IS TO BE LOADED .......................... 20
      5.1.2 SELECT THE PICTURE UPLOAD OPTION .................................................... 21
      5.1.3 SELECT PICTURE FILE LOCATION AND ENTER PICTURE INFORMATION ....... 22
      5.1.4 YOU ARE FINISHED! ................................................................................. 23

6 How to format a schematic ................................................................................................. 24
   6.1 FAQ regarding schematics .............................................................................................. 24
   6.2 Formatting a schematic using Irfanview .......................................................................... 25
      6.2.1 Installing Irfanview ............................................................................................. 25
      6.2.2 Schematic Format Procedure using Irfanview ...................................................... 25

7 How to upload a schematic ................................................................................................. 38
   7.1 Description ....................................................................................................................... 38

8 How to download a schematic ............................................................................................ 39
   8.1 Description ....................................................................................................................... 39
      8.1.1 GO TO THE MODEL PAGE WHERE THE SCHEMATIC IS LOCATED ............... 39

9 How to upload a schematic using the multi-page upload tool ....................................... 42
   9.1 Description ....................................................................................................................... 42
   9.2 Description ....................................................................................................................... 42
10 How to modify an existing manufacturer page ........................................... 42
  10.1 Description ......................................................................................... 42

11 How to create a new radio model......................................................... 42
  11.1 Description ......................................................................................... 42
  11.2 What new models are accepted........................................................... 43
  11.3 Use of generic models ....................................................................... 43
  11.4 How to classify Models with unknown manufacturers ....................... 44
  11.5 How to classify Models with unknown model numbers ....................... 44
  11.6 How to classify Homebrew Models..................................................... 44
  11.7 Creating a new model ....................................................................... 44
     11.7.1 Model Name, Model Type and Variant fields .................................. 44
     11.7.2 Year fields and uncertainty .......................................................... 44
     11.7.3 Type field .................................................................................... 44
     11.7.4 Reception Principle fields.............................................................. 44
        11.7.4.1 Reception Principle ZF/IF field ................................................. 45
        11.7.4.2 Reception Principle AF Stage(s) field ....................................... 45
        11.7.4.3 Reception Principle Special field ............................................. 46
     11.7.5 Number of AM and FM circuit fields .......................................... 46
     11.7.6 Power out fields .......................................................................... 47
     11.7.7 Wave bands field ........................................................................ 48
     11.7.8 Player field .................................................................................. 49
     11.7.9 Special field ................................................................................ 49
     11.7.10 Power Supply field ................................................................. 51
     11.7.11 Voltage field ............................................................................ 51
     11.7.12 Loudspeaker Type and size fields ............................................. 53
     11.7.13 Material field ........................................................................... 53
     11.7.14 Shape field ............................................................................... 53
     11.7.15 Dimensions fields ................................................................. 53
     11.7.16 Valves/Tubes & Semiconductor fields ........................................ 53
        11.7.16.1 Valves/Tubes “Number:” field ................................................. 53
           11.7.16.1.1 Valves/Tubes to be counted .......................................... 53
           11.7.16.1.2 Valves/Tubes NOT to be counted .................................. 53
        11.7.16.2 Valves/Tubes & Semiconductors lineup field ....................... 53
           11.7.16.2.1 Valves/Tubes & Semiconductors lineup field Guidelines ... 54
        11.7.16.3 Valves/Tubes & Semiconductors lineup field example ............ 55
        11.7.16.4 Semiconductors “Number:” field ......................................... 55
     11.7.17 Notes Section ........................................................................... 56
     11.7.18 New weight fields ..................................................................... 56
     11.7.19 Price fields ............................................................................... 56
     11.7.20 Mentioned in and Detail fields ................................................... 56
     11.7.21 Literature/Schematic fields ....................................................... 56
     11.7.22 Remarks for Admins field ......................................................... 56

12 How to modify an existing radio model ............................................ 56
  12.1 Description ....................................................................................... 56

13 How to upload pdf’s ........................................................................ 56
  13.1 Description ....................................................................................... 56

14 How to use the forum ..................................................................... 56
  14.1 Description ....................................................................................... 56

15 How to use the Schematic Finder .................................................... 56
Radio Museum Handbook

15.1 Description ............................................................................................................. 56

16 How to use the Literature Finder ........................................................................... 57
  16.1 Description .......................................................................................................... 57

17 How to search for a model ...................................................................................... 57
  17.1 Description .......................................................................................................... 57

18 How to upload tube and tube box pictures ............................................................. 57
  18.1 Description .......................................................................................................... 57

19 How to upload tube documentation ........................................................................ 57
  19.1 Description .......................................................................................................... 57

20 How to request that a tube, transistor or semiconductor be added to Radio Museum ......................................................................................................................... 57
  20.1 Description .......................................................................................................... 57

21 Administrator Sections ............................................................................................ 57
  21.1 Model Administrators ......................................................................................... 57
    21.1.1 The Model Administrator Page ..................................................................... 57
    21.1.2 Administration of Model Page Suggestions .................................................. 57
    21.1.3 Administration of New Model Proposals ...................................................... 57
    21.1.4 How to handle duplicate models ................................................................... 57
  21.2 Manufacturer Administrators ............................................................................. 57
  21.3 Schematic Administrators .................................................................................. 57
    21.3.1 Correcting a “Wrong” Schematic Finder reference entry .............................. 57
  21.4 Picture Administrators ....................................................................................... 57
  21.5 Collector Price Administrators ......................................................................... 57
    21.5.1 Determining if you have rights as a “Collectorprice-Admin” ...................... 57
    21.5.2 Changing or deleting a price .......................................................................... 57
  21.6 Tube/Semiconductor Administrators ................................................................. 57
  21.7 Tube/Semiconductor Picture Administrators ..................................................... 57
  21.8 Literature Finder Administrators ...................................................................... 57
  21.9 Museum Administrators .................................................................................... 57
  21.10 Audio Administrators ....................................................................................... 57
  21.11 CMS Administrators ....................................................................................... 57
  21.12 Forum Moderator Team .................................................................................... 57
List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-1</td>
<td>New Identity Administration Page</td>
<td>2</td>
</tr>
<tr>
<td>2-2</td>
<td>Radiomuseum Login OK Page</td>
<td>2</td>
</tr>
<tr>
<td>3-1</td>
<td>Advanced Search from “My eBay” page on eBay</td>
<td>3</td>
</tr>
<tr>
<td>3-2</td>
<td>Advanced Search” page on eBay</td>
<td>4</td>
</tr>
<tr>
<td>3-3</td>
<td>Selecting a radio on eBay “Sold” listings</td>
<td>4</td>
</tr>
<tr>
<td>3-4</td>
<td>Completed Listing page on eBay</td>
<td>5</td>
</tr>
<tr>
<td>3-5</td>
<td>Original Listing page on eBay</td>
<td>5</td>
</tr>
<tr>
<td>3-6</td>
<td>Search for the radio model on the home page</td>
<td>6</td>
</tr>
<tr>
<td>3-7</td>
<td>Selecting the Collector Price upload option</td>
<td>6</td>
</tr>
<tr>
<td>3-8</td>
<td>Entering information into the “Uploading Collector prices” pop-up window</td>
<td>7</td>
</tr>
<tr>
<td>3-9</td>
<td>Verifying information in the “Price has been stored” pop-up window</td>
<td>7</td>
</tr>
<tr>
<td>3-10</td>
<td>Updated model page with pricing information</td>
<td>8</td>
</tr>
<tr>
<td>4-1</td>
<td>Irfanview “File” pull-down menu</td>
<td>10</td>
</tr>
<tr>
<td>4-2</td>
<td>Picture before cropping</td>
<td>11</td>
</tr>
<tr>
<td>4-3</td>
<td>Adjusting cropping window</td>
<td>12</td>
</tr>
<tr>
<td>4-4</td>
<td>Picture after cropping</td>
<td>13</td>
</tr>
<tr>
<td>4-5</td>
<td>Irfanview “Image” pull-down menu</td>
<td>14</td>
</tr>
<tr>
<td>4-6</td>
<td>Irfanview “Resize/Resample image” window</td>
<td>15</td>
</tr>
<tr>
<td>4-7</td>
<td>Setting picture pixel width</td>
<td>16</td>
</tr>
<tr>
<td>4-8</td>
<td>Irfanview “File” pull-down menu</td>
<td>17</td>
</tr>
<tr>
<td>4-9</td>
<td>Irfanview “Image Quality” window</td>
<td>18</td>
</tr>
<tr>
<td>4-10</td>
<td>Irfanview “Save As” window</td>
<td>19</td>
</tr>
<tr>
<td>5-1</td>
<td>Search for the radio model on the home page</td>
<td>20</td>
</tr>
<tr>
<td>5-2</td>
<td>Select the picture upload option window</td>
<td>21</td>
</tr>
<tr>
<td>5-3</td>
<td>Picture file location and picture information window</td>
<td>22</td>
</tr>
<tr>
<td>5-4</td>
<td>Picture uploaded correctly window</td>
<td>23</td>
</tr>
<tr>
<td>6-1</td>
<td>Opening a file in Irfanview</td>
<td>25</td>
</tr>
<tr>
<td>6-2</td>
<td>Selecting a file to open in Irfanview</td>
<td>26</td>
</tr>
<tr>
<td>6-3</td>
<td>Schematic file opened in Irfanview</td>
<td>26</td>
</tr>
<tr>
<td>6-4</td>
<td>Schematic rotated to Portrait view</td>
<td>27</td>
</tr>
<tr>
<td>6-5</td>
<td>Schematic that requires fine rotation</td>
<td>28</td>
</tr>
<tr>
<td>6-6</td>
<td>Fine rotation window</td>
<td>28</td>
</tr>
<tr>
<td>6-7</td>
<td>Drawing box around the schematic</td>
<td>29</td>
</tr>
<tr>
<td>6-8</td>
<td>Schematic after cropping</td>
<td>29</td>
</tr>
<tr>
<td>6-9</td>
<td>Resize Schematic option in Irfanview</td>
<td>30</td>
</tr>
<tr>
<td>6-10</td>
<td>Resize/Resample image window</td>
<td>30</td>
</tr>
<tr>
<td>6-11</td>
<td>Decrease Color Depth option in Irfanview</td>
<td>31</td>
</tr>
<tr>
<td>6-12</td>
<td>Decrease color depth window</td>
<td>31</td>
</tr>
</tbody>
</table>
FIGURE 6-13: COLOR CORRECTIONS OPTION IN IRFANVIEW ................................................................. 32
FIGURE 6-14: COLOR CORRECTIONS WINDOW .................................................................................. 32
FIGURE 6-15: PALETTE OPTION IN IRFANVIEW ................................................................................ 33
FIGURE 6-16: PALETTE ENTRIES WINDOW ......................................................................................... 33
FIGURE 6-17: COLOR WINDOW ............................................................................................................ 34
FIGURE 6-18: SAVE AS OPTION IN IRFANVIEW .................................................................................. 35
FIGURE 6-19: SAVE PICTURE AS WINDOW ......................................................................................... 36
FIGURE 6-20: VIEW BUTTON IN WINDOWS EXPLORER ..................................................................... 37
FIGURE 6-21: SELECTING DETAILS VIEW IN WINDOWS EXPLORER ............................................... 37
FIGURE 6-22: EXAMPLE OF FILE THAT WAS ORIGINALLY LARGER THAN 600KB ............................ 38
FIGURE 8-1: SEARCH FOR THE RADIO MODEL ON THE HOME PAGE .............................................. 39
FIGURE 8-2: WINDOWS ON MODEL PAGE ........................................................................................ 40
FIGURE 8-3: FIRST SCHEMATIC IN LARGE WINDOW ......................................................................... 40
FIGURE 8-4: SAVING PDF SCHEMATIC ON YOUR COMPUTER .......................................................... 41
FIGURE 11-1: AUDIO AMPLIFICATION STAGE EXAMPLE ................................................................... 45
FIGURE 11-2: AM TUNED CIRCUIT EXAMPLE .................................................................................... 46
FIGURE 11-3: EXAMPLE OF IF STAGE TRANSFORMER CONSIDERED AS 1 AM TUNED CIRCUIT .... 47
FIGURE 11-4: NEW MODEL PAGE “VOLTAGE” FIELD ....................................................................... 51
FIGURE 11-5: NEW MODEL PAGE “VALVES/TUBES” AND “SEMICONDUCTOR” FIELDS ................. 53
FIGURE 11-6: NEW MODEL PAGE “VALVES/TUBES & SEMICONDUCTOR” FIELDS EXAMPLE .......... 55
FIGURE 11-7: RESULTING MODEL PAGE “VALVES/TUBES & SEMICONDUCTOR” FIELDS EXAMPLE .. 55
FIGURE 21-1: MOVE SCHEMATIC FILE EXAMPLE ............................................................................ 59
FIGURE 21-2: MOVE SCHEMATIC TO SAME MODEL ......................................................................... 60
FIGURE 21-3: CREATE NEW REFERENCE IF THE CORRECT REFERENCE IS NOT LISTED ................. 60
FIGURE 21-4: SELECT EXISTING REFERENCE IF THE CORRECT REFERENCE IS LISTED ................... 61
FIGURE 21-5: ENTERING A NEW ENTRY FOR THE SCHEMATIC FINDER ........................................... 61
FIGURE 21-6: SELECTING NOT CONTAINED IN THE LIST ABOVE OPTION ..................................... 62
FIGURE 21-7: SHOWING CORRECT SCHEMATIC FINDER REFERENCE ............................................. 62
1 Introduction

1.1 Description

Radiomuseum.org is a website with the purpose of documenting information related to antique radio. It is a "virtual antique radio" encyclopedia, where members continuously add information to the website. The process of adding information to the website is automated such that members can upload pricing information, pictures and schematics without human intervention. Members can also propose changes to existing model pages and propose new model page additions automatically. Having accurate information is one of the primary goals, thus there are “gates” built into the Radio Museum website software. Volunteer “Administrators” are assigned to the various gates to ensure that the information submitted by members is correct and readable.

The purpose of this document is to have a single place where all detailed descriptions of procedures and guidelines for both members and administrators are gathered together, making it easy to find any particular procedure or guideline (if a detailed reference is required).

This document contains the following:

- Step by step procedures which Radio Museum members can use to improve the Radio Museum website
- Guidelines that Radio Museum members can use to help explain details related to submitting new radio model (or radio manufacturer) proposals or making corrections to existing radio model (or radio manufacturer) pages
- Procedures which Radio Museum Administrators can use to understand how the software operates from the Administrators viewpoint
- Guidelines that Radio Museum Administrators can use to help make decisions on accepting or rejecting new radio model (or radio manufacturer) proposals and existing radio model (or radio manufacturer) pages

1.2 Radio Museum Goals

The major goals of Radio Museum are as follows:

- To document information on every radio (and radio related items) from around the world, including radios commercially produced, "homebrew" radios, kits, etc... (Refer to section 10.2 for a detailed description of what new models are accepted)
- To have the information on the Radio Museum website available in 5 different languages
- To ensure that the information on the Radio Museum website is correct (Quality of content)
- To ensure that the documentation on the Radio Museum website is very “readable” (Quality of schematic and other material is easy to read)
2 General Information

2.1 Enabling the “Automatic Login” Feature

When you log into the Radio Museum website, the “New identity administration” window appears.

a. Select the computer you are using from the “Your System” pulldown menu.
b. Select the browser you are using from the “Browser” pulldown menu.
c. Click the “Continue” button.

d. The “Radiomuseum Login OK” window will appear. Click the “To activate AutoLogin” box.
e. Click the red “GO” button.

You will now be automatically logged in every time you open the Radio Museum home page.
3 How to upload pricing information

3.1 Uploading a radio price to Radio Museum

One of the easiest ways for Radio Museum members to contribute information to the website is by uploading pricing information. Below are the instructions on how to upload pricing information to Radio Museum by gathering pricing information from Ebay.

Before discussing the price uploading procedure, here are questions that are frequently asked:

a) **What pricing information can I upload?**

One of the easiest places to find pricing information is on Ebay. Please upload Ebay pricing information on "Completed Listings" only? Do not upload offers from Ebay, only completed auctions! You can also upload pricing information on items you have purchased at radio swap meets, antique stores or individual sales (Items you have purchased using Craigslist for example).

**NOTE:** Do not include shipping costs in the price.

b) **What information is needed for pricing taken from Ebay?**

You must list the Ebay "seller name" and the Ebay "Item Number" in the “Remarks” section on the “Uploading Collector prices” page when you upload pricing information taken from Ebay.

3.1.1 **FIND PRICING INFORMATION IN FINISHED AUCTIONS ON EBAY**

a. Go to Ebay, and search on a particular radio brand or manufacturer (or just “antique radio”). Search for “completed listings” only (if you are logged onto Ebay, click on “Advanced” in the upper right corner of your “My eBay” page).

![Figure 3-1: Advanced Search from “My eBay” page on Ebay](attachment:image.png)
b. The “Advanced Search” page will appear. Enter the radio brand you are looking for in the “Enter keywords or item number” box, click the “Sold listings” box, and then click the blue “Search” box.

![Figure 3-2: Advanced Search page on Ebay](image)

After picking Philco in this example, many recent sales of Philco items came up. From the list, select a particular item. In this example, a Philco model 40-155 was found that sold for $79.95 on Jan-26, 2015. Click on the item selected.

![Figure 3-3: Selecting a radio on Ebay “Sold” listings](image)
The completed listing page will appear that shows the winning bid information for the radio. Click “See original listing”.

Figure 3-4: Completed Listing page on Ebay

e. The original listing page will appear. This page has all the information needed for uploading pricing information to the Radio Museum website. From this page, review the condition of the item, along with the seller name, the item number, the selling price and the date the item sold.

Figure 3-5: Original Listing page on Ebay
3.1.2 GO TO THE MODEL PAGE WHERE THE PRICE IS TO BE LOADED

a. From the Radio Museum Home Page, enter your user name and password, then search for the model you have prices for. Enter the model number and manufacturer of the radio into the advanced search area, then click “GO”. This will occasionally take you to a list of different versions of the radio, in which case you should look at the existing pictures posted for each model to determine which model you should upload to.

Figure 3-6: Search for the radio model on the home page

b. The model page for that model will appear. Select “Collector Price upload” from the “Uploads & questions” pull-down menu.

Figure 3-7: Selecting the Collector Price upload option
c. The “Uploading Collector prices” pop-up window will appear. Enter the information from the Ebay listing. For the selling price, please round to the nearest dollar amount (Do not enter “cents). Make sure to enter the Ebay seller and item number into the “Remarks” section. Also include a few comments that describe the condition of the cabinet and chassis. When finished, click the “Save” button.

![Figure 3-8: Entering information into the “Uploading Collector prices” pop-up window](image)

d. The “price has been stored” pop-up window appears. Verify that the information is correct, and then click the “Close window” button.

![Figure 3-9: Verifying information in the “price has been stored” pop-up window](image)
e. Return to the radio model page and then press the “F5” key on your keyboard. This update (refresh) the radio model page. You should now see the price you just uploaded on the model page.

![Figure 3-10: Updated model page with pricing information](image)

You are finished! Just a single upload of a collector’s price will credit you with enough points to view or download 21 schematics or an even larger number of high resolution pictures. In a few hours you can upload enough collectors' prices so that you don't have to worry about UACS points for a few years.
How to format a picture

4.1 Formatting a picture using Irfanview

It is no longer required to format a picture before uploading it to Radio Museum! However we highly recommend performing a minimal picture format which will improve the quality of the picture!

Before discussing the picture formatting procedure, here are questions that are frequently asked:

c) What pictures to submit?

Please submit multiple photographs of each model. Please include a photograph from an angle that has the front, side and top of the radio (Similar to the old radio ads, see the radio picture used in this tutorial.) Also include views of the front, back, sides, bottom, chassis, speaker and any labels or metal plates that have the radio model number and/or chassis number. If you are restoring the radio, “Before” and “After” pictures are most welcome!

d) What if pictures of the model already exist on the model page?

We welcome and encourage members to upload pictures to models even if pictures already exist. It does not matter how many pictures exist on a model page.

e) What picture sizes should I take with my camera?

The Radio Museum server will adjust pictures to fit into a 1400 pixel by 2100 pixel size (Usually written as 1400 x 2100, with 1400 being the horizontal “X” dimension and 2100 being the vertical “Y” dimension). Thus, it is best to have your camera set to take pictures with a higher resolution than this, like 4000 x 3000 for example.

Before uploading a picture to Radio Museum, the picture can be formatted using image processing software. There are 3 easy steps in preparing a picture. The procedure below uses the IRFANVIEW imaging software. A free download is available from: http://www.irfanview.com/. This tutorial also uses a plug-in, so also download and install the plug-ins. The Irfanview software version used in the examples below is version 4.38, however this procedure will work with other versions also.

Once you have Irfanview and the plug-ins installed on your computer, you can begin the formatting process:
4.1.1 CROP THE PICTURE

This step is optional, but is highly recommended. Cropping the picture means eliminating as much of the background as possible.

a. Start Irfanview, then go to the “File” pull-down menu and select “Open”.

![Irfanview “File” pull-down menu](image)

Figure 4-1: Irfanview “File” pull-down menu

b. In the pop-up window, select the picture file you want to format by double clicking on the file name. The picture will appear in Irfanview. If the picture is too large or small,
you can adjust the size of the picture using the "+" and "-" magnifying glass buttons on the menu bar until the picture fills the screen. Notice in the example below how the background distracts from the radio image.

Figure 4-2: Picture before cropping
c. Place the mouse pointer somewhere in the upper left side of the picture, then while holding down the left mouse button, move the mouse pointer to the lower right side of the picture, then release the left mouse button. You will now see a rectangle drawn on the picture. You want this rectangle to contain just the complete radio image, so adjust the rectangle as required by placing the mouse pointer over one side of the rectangle line, then while holding the left mouse button down, you can move the side of the rectangle until you are near the edge of the radio itself, then release the left mouse button. (The rectangle can be removed by clicking outside of the rectangle). Do this for all 4 sides of the picture. The rectangle should look like this when you are finished.

Figure 4-3: Adjusting cropping window
d) While holding the “Cntl” key, hit the letter “Y”, then release both keys. The picture should now be cropped to within the rectangle window. (You can also use the “Cut – Area outside of the selection” option in the “Edit” pull-down menu to perform the same action). The picture now looks better without the background distractions.

Figure 4-4: Picture after cropping
4.1.2 ADJUST DIMENSIONS OF THE PICTURE

This step is also optional. Large pictures that are uploaded to the website will have the picture size reduced to meet the limit of 1400 pixels wide by 2100 pixels tall. However reducing the picture size using Irfanview will give a higher picture quality. Thus it is ideal to make the picture as large as possible without exceeding these limits. In most cases the 1400 width will be the limiting dimension, but for very tall pictures, the 2100 height will be the limiting dimension.

a. Select the “Image” pull-down menu and click “Resize/Resample”:

![Irfanview “Image” pull-down menu](image1.png)

Figure 4-5: Irfanview “Image” pull-down menu
b. A pop-up will appear with the picture size information. Make sure that “pixels” is selected for the units and also that the “Preserve aspect ratio (proportional)” option is selected.

![Figure 4-6: Irfanview “Resize/Resample image” window](image-url)
c. In the “Width” box, type “1400”. If the Height changes to a number greater than 2100, then type in 2100 for the Height (The Width will then be less than 1400, but that is OK). When finished, hit the “OK” button.

Figure 4-7: Setting picture pixel width
4.1.3 SAVING THE PICTURE FILE

The picture file name must use the Radio Museum picture naming convention. There is no longer a file size limit for pictures. Thus, the file can now be saved without worrying about the file size.

a. To rename and save the picture, select the “File” pull-down menu and click “Save for Web...(Plugin)”:  

![Irfanview “File” pull-down menu](image)

Figure 4-8: Irfanview “File” pull-down menu
b. A pop-up window appears. Click the “JPEG” button. Then adjust the “Quality” slider to 70%. Then click the “Save” button.

Figure 4-9: Irfanview “Image Quality” window
c. The “Save As” pop-up window appears. Navigate to the folder where you want to save the file. Now give the file its correct filename format by typing the name into the “File name:” line.

**The file name format is as follows:**

*Manufacturer_Model Number_View*

For the picture in the example, this file name was used:

beverley_605_front1 (The .jpg suffix gets added automatically by the Irfanview software)

Now save the picture by clicking the “Save” button.

Figure 4-10: Irfanview “Save As” window

The file is now ready to be uploaded to the Radio Museum Website.
5 How to upload a picture

5.1 Uploading a picture to Radio Museum

Here are the instructions on how to upload a picture to Radio Museum. Before you begin the upload process, the picture may be formatted using image processing software such as Irfanview or Photoshop (The photograph formatting procedure is not described here – See Chapter 3 for the picture format procedure). Once you have formatted the picture, you are then ready to upload it. Log on to www.radiomuseum.org with your user name and password and let's get started!

5.1.1 GO TO MODEL PAGE WHERE PICTURE IS TO BE LOADED

From the Radio Museum Home Page, search for the model you have pictures of. Enter the model number and manufacturer of the radio into the advanced search area, then click “GO”. This will occasionally take you to a list of different versions of the radio, in which case you should look at the existing pictures posted for each model to determine which model you should upload to.

Figure 5-1: Search for the radio model on the home page
5.1.2 SELECT THE PICTURE UPLOAD OPTION

From the radio model page, select the “Picture upload” option from the “Uploads and questions” pull-down menu.

Figure 5-2: Select the picture upload option window
5.1.3 SELECT PICTURE FILE LOCATION AND ENTER PICTURE INFORMATION

A pop-up window will appear:

a. Click the “Browse” button and then navigate to the folder where the picture is located. Select the picture file to be uploaded and click “Open”.

b. The “Source” of the picture must be selected.

c. From the “Image content” pull-down menu, please select the category that best describes what was photographed.

d. From the “Image quality” pull-down menu, please select the category that best describes the photograph quality.

e. Add a Caption for the picture. The Caption is optional for pictures from your own radio collection, however the source of the picture must be entered into the Caption area if the picture is not yours. For pictures taken from Ebay, you must enter the sellers name and the Ebay item number into the caption area. You can use the following statement when giving credit for the photograph if it was taken from Ebay:
   “eBay advertisement by seller [put Ebay seller name here], Item Number [put Ebay item number here]. Contact Radio Museum to provide more complete photo credit information or request removal”.

f. When you are finished, click the “Send” button.

Figure 5-3: Picture file location and picture information window
5.1.4 YOU ARE FINISHED!

A pop-up will appear once the picture has been uploaded. Click the “Close window” button and you are finished. A picture administrator will review your picture and if approved, will be posted in the radio model web page.

**HINT:** If you have more pictures to upload to the same model page, do NOT click the “Close window” button on the “Upload pictures” window but instead, press the “Backspace” key on your keyboard. This will take you back to the previous “To upload a picture” window, where you can select another picture for the same model. Please make sure to also update the Source, the Image content, the image quality and the Caption if required.

![Figure 5-4: Picture uploaded correctly window](image-url)
6. How to format a schematic

6.1 FAQ regarding schematics

Before discussing the schematic formatting procedure, here are questions that are frequently asked:

a) How should I set my scanner settings when scanning schematics?

I. **SCANNER RESOLUTION** - Please set your resolution to be **300 DPI (Dots Per Inch)** or higher. For most schematics, 300 DPI is sufficient. For small schematics or for schematics with small text, use 400 DPI or 600 DPI.

II. **IMAGE TYPE** – Please scan as “**Gray scale**”. Do not scan as “Color” or “Black & White”.

III. **IMAGE FORMAT SAVED** – Please save the image as a “**TIFF**” file so that the file extension is *.tif.

b) What data or information should be formatted and uploaded as a schematic (as opposed to being uploaded as a picture)?

In general, pictures and sales literature should be scanned, formatted and uploaded as pictures. Most other material should be scanned, formatted and uploaded as a schematic. This includes schematics, alignment instructions, parts lists (or BOMS’ – Bill Of Materials), operation manuals, dial cord drawings, PCB layouts, wiring diagrams, mechanical drawings, descriptions, and any other material that contain mostly schematics or text.

c) What if schematics of the model already exist on the model page?

We welcome and encourage members to upload additional schematics to models if the existing schematics have poor quality or if the existing schematics come from a different source. So for example, if the existing schematics came from a “Riders” manual, and you have the schematic from a radio manufacturer manual, we encourage you to scan, format and upload the manufacturer schematic to the radio model page also.

Before uploading schematics to Radio Museum, the schematics must be formatted using image processing software. Formatting is required so that a high-quality schematic is created and has a small file size. There are 8 steps in preparing a schematic. The procedure below uses the **IRFANVIEW** imaging software. A free download is available from: [http://www.irfanview.com/](http://www.irfanview.com/). The Irfanview software version used in the examples below is version 4.50, however this procedure will work with other versions also.

Once you have Irfanview installed on your computer, you can begin the formatting process.

**NOTE:** Please follow these instructions in the sequence given!! Not following the given sequence will create schematic files that are too large or do not have good quality!!
6.2 Formatting a schematic using Irfanview

6.2.1 Installing Irfanview

Before uploading schematics to Radio Museum, the schematics must be formatted using image processing software. Formatting is required so that a high-quality schematic is created and has a small file size. There are 8 steps in preparing a schematic. The procedure below uses the Irfanview imaging software. A free download is available from: [http://www.irfanview.com/](http://www.irfanview.com/). The Irfanview software version used in the examples below is version 4.50, however this procedure will work with other versions also.

Once you have Irfanview installed on your computer, you can begin the formatting process.

**NOTE: Please follow these instructions in the sequence given!! Not following the given sequence will create schematic files that are too large or do not have good quality!!**

6.2.2 Schematic Format Procedure using Irfanview

Below are the 8 steps in preparing a schematic:

1) LOAD THE SCHEMATIC

   a. Start Irfanview, then select “Open” from the “File” pull-down menu.
b. In the pop-up window, select the schematic file you want to format by double clicking on the file name. The schematic will appear in Irfanview. If the schematic is too large or small, you can adjust the size of the schematic by going to the “View” pull-down menu, selecting “Display options”, then selecting “Fit images to window”. The complete schematic should then show in the window.

Figure 6-2: Selecting a file to open in Irfanview

Figure 6-3: Schematic file opened in Irfanview
2) ROTATE THE SCHEMATIC (If Required)

a. The schematic should be in portrait mode and should not be upside down. If the schematic needs to be rotated, select “Rotate Right (clockwise)” from the “Image” pulldown menu. If necessary, repeat this procedure until the picture is in portrait mode and is not upside down.

Figure 6-4: Schematic rotated to Portrait view
b. The schematic should be aligned in the window. If the schematic is NOT aligned in the window (See picture below), then align the schematic by selecting the "Custom/Fine rotation", then type in the fine angle to align the schematic. Usually only a fraction of a degree is required (Example: 0.4). Positive numbers rotate the schematic clockwise, negative numbers rotate the schematic counter-clockwise.

Figure 6-5: Schematic that requires fine rotation

Figure 6-6: Fine rotation window
3) CROP THE SCHEMATIC

a. Place the mouse pointer somewhere in the upper left side of the schematic, then while holding down the left mouse button, move the mouse pointer to the lower right side of the schematic, then release the left mouse button. You will now see a rectangle drawn on the schematic. You want this rectangle to contain just the complete schematic, so adjust the rectangle as required by placing the mouse pointer over one side of the rectangle line, then while holding the left mouse button down, you can move the side of the rectangle until you are near the edge of the schematic itself, then release the left mouse button. (The rectangle can be removed by clicking outside of the rectangle). Do this for all 4 sides of the schematic. The rectangle should look like the picture below when you are finished.

b. While holding the “Cntl” key, hit the letter “Y”, then release both keys. The schematic should now be cropped to within the rectangle window. (You can also use the “Cut – Area outside of the selection” option in the “Edit” pull-down menu to perform the same action). If you are not happy with the result, select “Undo” from the “Edit” pulldown menu and try again.

Figure 6-7: Drawing box around the schematic
Figure 6-8: Schematic after cropping
4) ADJUST DIMENSIONS OF SCHEMATIC
    a. The schematic size should be set for a 27 cm height. Select the “Image” pull-down menu and click “Resize/Resample”:

![Figure 6-9: Resize Schematic option in Irfanview](image)

b. The “Resize/Resample image” window will appear with the schematic size information. Make sure that “cm” is selected for the units and also that the “Preserve aspect ratio (proportional)” option is selected. Type in “27” for the Height. If you have scanned the schematic at some higher resolution than 300 DPI (such as 400 or 600 DPI), then type in “300” for the DPI. When finished, hit the “OK” button.

![Figure 6-10: Resize/Resample image window](image)
5) **DECREASE COLOR DEPTH OF SCHEMATIC**
   
a. The number of colors used in the schematic needs to be reduced. Select “Decrease Color Depth...” from the “Image” pulldown menu.

![Decrease Color Depth option in Irfanview](image)

*Figure 6-11: Decrease Color Depth option in Irfanview*

b. The “Decrease color depth” window will appear. Select the “Custom” option and type in “4”. Make sure that the “Use Floyd-Steinberg dithering” option is NOT enabled. When finished, hit the “OK” button.

![Decrease color depth window](image)

*Figure 6-12: Decrease color depth window*
6) ADJUST SCHEMATIC COLORS

   a. Select “Color corrections…” from the “Image” pulldown menu.

      Figure 6-13: Color Corrections option in Irfanview

   b. The “Color corrections” window will appear. The goal is to adjust the contrast and gamma correction controls so that the background is a clean white color and the schematic lines are deep black and solid. In most cases, setting the “Contrast” to “77” and the “Gamma correction” to 0.46” gives very good results. Leave the “Saturation” value at “0”.

      Click the “Apply to original” button, which will apply the changes to the full size schematic and allow you to see the results of the adjustments. It is sometimes necessary to set the Contrast and Gamma correction values to different values in order to get a good quality schematic. You can re-adjust the values and then click the “Apply to original” button again to review the result. When finished, hit the “OK” button.

      Figure 6-14: Color Corrections window
7) SET SCHEMATIC BACKGROUND TO WHITE

a. Select "Palette" from the "Image" pull-down menu, then select "Edit palette…".

Figure 6-15: Palette option in Irfanview

b. The "Palette entries" window will appear. Double click on the lightest color that is shown.

Figure 6-16: Palette Entries window
c. The “Color” window will appear. Click the White square in the lower right corner. Then click “OK”.

In the “Palette entries” window, click “OK”.

![Color window](image)

**Figure 6-17: Color window**
8) SAVE SCHEMATIC FILE AND CHECKING FILE SIZE

d. To save the schematic, select the “Save as..” option from the “File” pull-down menu.

![Figure 6-18: Save As option in Irfanview](image)

- The “Save Picture As..” pop-up window appears. Select the location (folder) where you want to save the schematic in the “Save in:” pull-down menu. Select the “PNG – Portable Network Graphics” option from the “Save as type:” pull-down menu. Then type in the name of the schematic file into the “File name:” pull-down menu (See file naming convention below). When finished, hit the “Save” button.

f. The file name (naming convention) must follow the following specific format:

   Country Code_Manufacturer_Model#_Document Type.png
   (The .png suffix gets added automatically)

Here are examples of file names:

- usa_FairbanksMorse_57T0_sch1 = complete SCHematic
- usa_FairbanksMorse_57T0_sch2 = another complete Schematic
- usa_FairbanksMorse_57T0_sch1a = left hand part of a divided Schematic
- usa_FairbanksMorse_57T0_sch1b = right hand part of a divided Schematic
- usa_FairbanksMorse_57T0_align = Alignment
- usa_FairbanksMorse_57T0_cord = Cord stringing
- usa_FairbanksMorse_57T0_lay = Print layout, also 1, 2, ...
- usa_FairbanksMorse_57T0_prts = Parts list, also 1, 2,...(C + R)
- usa_FairbanksMorse_57T0_spare = Spare parts
- usa_FairbanksMorse_57T0_descr = Description, also 1, 2, ...
- usa_FairbanksMorse_57T0_titl = Title page of Service manual (with picture)
- usa_FairbanksMorse_57T0_data = Data (e.g. Tube lineup etc.), no picture
- usa_FairbanksMorse_57T0_pos = Position plan (of components), also 1, 2, ...
- usa_FairbanksMorse_57T0_wire = Wiring
- usa_FairbanksMorse_57T0_mech = mech drawing, exploded view, etc., also 1, 2, ...
- usa_FairbanksMorse_57T0_misc = Miscellaneous, (try to avoid please)
g. The file size must be less than 600KB. Using Windows Explorer, navigate to the directory where the schematic was saved. Change the view to “Details”, which will then show the size of the files listed in the directory. The file size of the saved schematic should be less than 600KB. If the procedure listed above was followed, the file size should be well under this file size.

Even when the procedure is followed, there will still be some cases where the file size will be above the 600KB limit. Chassis views are examples of files that may exceed the file size (See example below). Try using the following techniques to reduce the file size:

- When adjusting the schematic colors, try using different values for Contrast and Gamma Correction
- When decreasing the color depth, try using a smaller number of colors
- If all else fails, setting the DPI to less than 300 when adjusting the dimensions of the schematic will further reduce the file size. Setting the DPI to 200 almost always works.
Figure 6-20: View button in Windows Explorer

Figure 6-21: Selecting Details View in Windows Explorer
Figure 6-22: Example of file that was originally larger than 600KB

The file is now ready to be uploaded to the Radio Museum Website.

7 How to upload a schematic

7.1 Description

The
8 How to download a schematic

8.1 Description

Here are the instructions on how to download a schematic from Radio Museum. Only members of Radio Museum who are in good standing (Members not on restricted access) can download schematics. Log on to www.radiomuseum.org with your user name and password and let's get started!

8.1.1 GO TO THE MODEL PAGE WHERE THE SCHEMATIC IS LOCATED

a. From the Radio Museum Home Page, search for the model which has the schematic you would like to download. Enter the model number and manufacturer of the radio into the advanced search area, then click “GO”. This will occasionally take you to a list of different versions of the radio, in which case you should look at the existing pictures posted for each model to determine which model has the schematic you are interested in downloading.

Figure 8-1: Search for the radio model on the home page
b. The model page for that model will appear. Each model page has a large window on the upper left side of the page. If pictures are available, then a picture is shown in the large window. If only schematics are available, then a portion of the schematic is shown in the large window. If the model has no pictures OR schematics, then there will be no large or small windows on the model page. Assuming both pictures and schematics are available, they will appear in 2 smaller windows on the right side of the model page, with schematics in the small top window and pictures in the small bottom window.

![Figure 8-2: Windows on model page](image)

![Figure 8-3: First Schematic in large window](image)

c. Place your cursor over the small schematic window and then click the left mouse button. The schematic will now be displayed in the large window.
d. Place your cursor over the large window and then click the left mouse button. The first schematic page will now download to your computer as a pdf file. A pop-up window will appear that contains the schematic. To save the schematic on your computer, click “File” on the menu bar and then select “PDF” from the “Save As” pulldown menu.

![Figure 8-4: Saving pdf schematic on your computer](image)

e. If there are more schematic pages available on the model page that you want to download, then select the next schematic page by moving the red colored scroll bar in the small schematic window and then click on the next schematic page. This next schematic page will now appear in the large window. Click on the large window and it will download to your computer. Save the second schematic page as before. Repeat this procedure until you have downloaded all of the schematics you need.
9 How to upload a schematic using the multi-page upload tool

9.1 Description

The How to create a new manufacturer

9.2 Description

The

10 How to modify an existing manufacturer page

10.1 Description

The

11 How to create a new radio model

11.1 Description

This section describes the guidelines for creating a new model in the Radio Museum database. This is done by submitting a “New Model Proposal”. The process for adding a new model is as follows:

a) The member should search Radio Museum for the new model that is to be submitted. This is an important step. Many new model proposals are rejected because they already exist in the Radio Museum database!

b) If the new model does not yet exist in the Radio Museum database, the member then fills out the New Model Proposal Page.

c) Documentation that supports the proposal should be uploaded to the New Model Proposal page before the model proposal is submitted.

d) The New Model Proposal is checked by at least two Model Administrators. The Model Administrators may add, delete or change any of the data on the New Model Proposal page.

e) If two or more Model Administrators vote to approve the New Model Proposal, then the new model is accepted and is added to the Radio Museum database. If two Model Administrators vote to reject the new model proposal, then the new model is rejected. In the case where some Model Administrators vote to accept the model and other Model Administrators vote to reject the model, then the model will be accepted if there are two more accept votes as compared to the reject votes. Likewise, the model will be rejected if there are two more reject votes as compared to the accept votes.
f) If the new model proposal is accepted, and if the member who submitted the new model proposal uploaded pictures to the new model proposal, then the pictures will be reviewed by the picture administrator before being added to the new model page. Schematics that were uploaded also go through a similar procedure.

g) The disposition of the model (Approved or Rejected) will be documented in an e-mail that is sent to the member who proposed the new model.

11.2 What new models are accepted

The following types of models will be accepted as a new model:

- All radio receivers
- Commercial receivers
- Amateur receivers
- Detector radio’s (Crystal radio’s, radios without tubes or transistors)
- All television sets and monitors
- Car radio’s and car sound players/recorders
- Combination models (Radio and/or phonograph and/or TV, etc...)
- Television cameras and studio equipment
- Digital/Analog terrestrial, Internet and SAT receivers
- Radio modules and parts
- Pre-stage adapters/converters (SW/FM/VHF/UHF, etc) and frequency converters
- RF Amplifiers
- Transmitter and Receiver, Amateur Transmitter/Receiver
- Transmitter, Amateur Transmitter
- Military Equipment
- Mobile Equipment
- Citizen Band Equipment
- Morse Cose Equipment, including keys
- Microphones and pick-up elements
- Loudspeakers, headphones, earphones
- Antennas, Couplers
- Cabinets only
- Power supplies/conditioners, battery chargers
- Audio Amplifiers, mixers
- Sound/Video Recorder and/or Player
- Talking Machine – Mechanical Gramaphone/Phonograph
- Test Equipment, Service or Lab Equipment
- Radio and/or Test Equipment Kits and/or building instructions
- Amateur Equipment
- Catalogs, other paper documentation (Check if this is better uploaded to the literature finder)
- Medical devices that contain at least 1 tube (value)
  (More devices to be added here?)

The following types of models will NOT be accepted as a new model:

11.3 Use of generic models
11.4 How to classify Models with unknown manufacturers

The

11.5 How to classify Models with unknown model numbers

The

11.6 How to classify Homebrew Models

For USA Homebrew models, there are 3 different categories of “Homebrew” models listed as manufacturers. Underneath each of these manufacturers, there is a list of models, with each model type being a category of the type and time period of homebrew (Example: Crystal set before 1930).

a) “Homebrew – ORIGINAL, USA”

This should be used as the manufacturer for homebrew sets. Here is the link to the model types for the USA sets:
http://www.radiomuseum.org/m/homebrew-o_usa_en_1.html

b) “Homebrew – RECENT but NOT Replica, USA”

This should be used as the manufacturer for homebrew sets which are NOT replica’s, but are “old” looking, made from old/new parts or are old kits recently assembled. Here is the link to the model types for the USA sets:
http://www.radiomuseum.org/m/homebrew-n_usa_en_1.html

c) “Homebrew – REPLICA, USA”

This should be used as the manufacturer for homebrew sets that contain a visible stamp “Replica”. Here is the link to the model types for the USA sets:
http://www.radiomuseum.org/m/homebrew-r_usa_en_1.html

11.7 Creating a new model

11.7.1 Model Name, Model Type and Variant fields

11.7.2 Year fields and uncertainty

11.7.3 Type field

11.7.4 Reception Principle fields

Note to add: If radio has RF stage for FM section but no RF stage for AM, use “Super-Heterodyne (Super in general) in Reception principle pull-down menu.
11.7.4.1 Reception Principle ZF/IF field

11.7.4.2 Reception Principle AF Stage(s) field

This field is used to indicate the number of audio frequency (AF) amplification stages in a receiver. In most receivers, these are the amplification stages after the detector stage. An example is shown below, with the audio amplification stages shown in **GREEN**. This example has 2 audio frequency amplification stages.

![Figure 11-1: Audio Amplification Stage example](image)

**Notes on audio frequency amplification stages:**
- A class B or class AB push pull output stage counts as 1 AF stage
- If a push-pull stage has a phase inversion tube or transistor, the phase inversion tube or transistor does not count as an AF stage
11.7.4.3 Reception Principle Special field

11.7.5 Number of AM and FM circuit fields

These fields are used to indicate the number of tuned circuits in the receiver that are **ADJUSTABLE**, keeping in mind that a "tuned" circuit is an LC tank circuit comprising of an inductor and capacitor connected in parallel. As an example, a standard superhet AM receiver would have the frequency select tuned circuit (1) and the local oscillator tuned circuit (2). Note that the ganged tuning capacitor would have 2 sections used in these two circuits. Next, the Intermediate Frequency (IF) tuned circuits are counted, with a standard receiver having 4 tuned IF circuits. Adding all of these together would give 6 tuned circuits. The example described is shown below, with the AM tuned circuits shown in **RED**.

![Figure 11-2: AM tuned circuit example](image)

**Notes on tuned circuits:**

- An RF stage in front of the frequency select stage is an additional tuned circuit if it is adjustable (usually indicated by the ganged tuning capacitor having 3 sections)
- The adjustable part of the tuned circuit can be a variable capacitor or a variable inductor (or both)
- Tank circuits that are not adjustable are not counted
- IF cancellation circuits and wave-trap circuits are not counted
- In AM/FM receivers, only the AM adjustable tuned circuits count toward the AM count. Likewise, only the FM adjustable tuned circuits count toward the FM count.
- In FM receivers, the FM demodulator is considered an FM tuned circuit if it is adjustable
- Some IF transformers have only 1 tuning adjustment (usually in inexpensive AM receivers) and so count as only 1 tuned circuit (assuming the capacitors are fixed). See figure below:

![Figure 11-3: Example of IF stage transformer considered as 1 AM tuned circuit](image)

11.7.6 Power out fields
11.7.7 Wave bands field

The "Wave bands" field has a pull-down menu with the following selections:

Table 1: "Wave bands" field pull-down menu selections

<table>
<thead>
<tr>
<th>Pull-Down Menu Selection</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not specified</td>
<td>Use if wave bands are not known</td>
</tr>
<tr>
<td>- without [AAA]</td>
<td>Use for models that do not have wave bands</td>
</tr>
<tr>
<td>Broadcast only (MW). [B]</td>
<td>Self explanatory</td>
</tr>
<tr>
<td>Broadcast (BC) and FM or UHF. [BF]</td>
<td>Self explanatory</td>
</tr>
<tr>
<td>Broadcast (MW) and Long Wave. [BL]</td>
<td>See Note 1 below</td>
</tr>
<tr>
<td>Broadcast (MW) and Tropical/Marine/Police Band(s) = 150-200m. [Mar/Tro/Pol]</td>
<td>150-200m corresponds to 1.5 to 2MHz range.</td>
</tr>
<tr>
<td>Broadcast (MW), Police, sometimes also early TV (75-200m) [BPT]</td>
<td>75-200m corresponds to 1.5 to 4MHz range.</td>
</tr>
<tr>
<td>Broadcast and Longwave in ONE range [BL1]</td>
<td></td>
</tr>
<tr>
<td>Broadcast and Shortwave(SW). [BS]</td>
<td></td>
</tr>
<tr>
<td>Broadcast plus 2 Short Wave bands [BS2]</td>
<td></td>
</tr>
<tr>
<td>Broadcast plus more than 2 Short Wave bands [BSX]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, (BC) Long Wave (LW), 2 x SW and FM or UHF. [BLS2F]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, 2 Short Wave plus FM or UHF. [BS2F]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, Long Wave and 2 x Short Wave. [BLS2]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, Long Wave and FM or UHF. [BLF]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, Long Wave and more than two Short Wave bands. [BLSX]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, Long Wave and Short Wave. [BSL]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, Long Wave, more than 2 x SW plus FM or UHF. [BLSXF]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, Long Wave, Short Wave plus FM or UHF. [BLS]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, more than 2 SW bands plus FM or UHF. [BSXF]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, Short Wave plus FM or UHF. [BSF]</td>
<td></td>
</tr>
<tr>
<td>Broadcast, Short Wave(s) and Police. [BSP]</td>
<td></td>
</tr>
<tr>
<td>DAB and FM, perhaps with Streaming [DABFM] [AAB]</td>
<td></td>
</tr>
<tr>
<td>FM Broadcast Band Only [FM]</td>
<td></td>
</tr>
<tr>
<td>Internet Streaming [Internet]</td>
<td></td>
</tr>
<tr>
<td>Long Wave and FM or UHF [LF]</td>
<td></td>
</tr>
<tr>
<td>Long Wave and/or Very Low Frequency (VLF). [L]</td>
<td></td>
</tr>
<tr>
<td>Police (only 50-200m). [POL]</td>
<td>50-200m corresponds to 1.5 to 6MHz range.</td>
</tr>
<tr>
<td>Ready for FM but has not all AM bands (not LW MW SW). [V]</td>
<td></td>
</tr>
<tr>
<td>Ready for FM, has Broadcast, Long Wave, several Short Wave. [BLSXV]</td>
<td></td>
</tr>
<tr>
<td>Ready for FM, has Broadcast, Long Wave, Short wave. [BLSV]</td>
<td></td>
</tr>
<tr>
<td>SAT-IF [SAT]</td>
<td></td>
</tr>
<tr>
<td>Short Wave (SW only) [S]</td>
<td></td>
</tr>
<tr>
<td>Short Wave (SW) and FM or UHF. [SF]</td>
<td></td>
</tr>
<tr>
<td>Short Wave (SW) and Long Wave (LW) only. [SL]</td>
<td></td>
</tr>
<tr>
<td>VHF incl. FM and/or UHF (see notes for details) [VHF/UHF]</td>
<td></td>
</tr>
<tr>
<td>Wave Bands given in the notes. [X]</td>
<td></td>
</tr>
</tbody>
</table>
NOTES:

1. Some 1920’s radios had the wavebands labeled as LW and SW, however at that time there was no SW band as we know it today and so the SW band was actually the Medium Wave (Broadcast) band. In these cases, the “WAVEBAND” field selected should be LW and this should be clarified in the NOTES section on the model page.

2. Police Band Definition – The “Police band” was used in the USA from the late 1920’s up to the mid 1960’s. The general frequency range used was between 1600 and 2500kHz, although most use was grouped in the 1550 – 1750kHz and 2300 – 2490kHz ranges. In 1936, Motorola produced the “Police Cruizer” Radio (Model 60P), which covered the frequency range of 1550 – 2800kHz and used a crystal to select the specific operating frequency used by the police department.

11.7.8 Player field

11.7.9 Special field

The “Special” field has a pull-down menu with the following selections:

**Table 2: "Special" field pull-down menu selections**

<table>
<thead>
<tr>
<th>Pull-Down Menu Selection</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advertising article (not radio)</td>
<td>Self explanatory</td>
</tr>
<tr>
<td>Converter</td>
<td>Self explanatory</td>
</tr>
<tr>
<td>Guitar Amplifier</td>
<td>Self explanatory</td>
</tr>
<tr>
<td>Hearing aid</td>
<td>Self explanatory</td>
</tr>
<tr>
<td>Hi-Fi equipment</td>
<td>High Fidelity receivers, tuners, amplifiers</td>
</tr>
<tr>
<td>Loudspeaker + integ Amplifier</td>
<td>Speaker system with integrated audio amplifier</td>
</tr>
<tr>
<td>Mechanical Television</td>
<td></td>
</tr>
<tr>
<td>Power: B-Battery Eliminator</td>
<td>Self explanatory</td>
</tr>
<tr>
<td>Power: Charger for A-Batteries</td>
<td>Self explanatory</td>
</tr>
<tr>
<td>Power Supply (not only Batt El.)</td>
<td></td>
</tr>
<tr>
<td>Radio Control (+Remote Wire etc)</td>
<td></td>
</tr>
<tr>
<td>Radio with other functions</td>
<td></td>
</tr>
<tr>
<td>Retro-look – not smaller orig.</td>
<td></td>
</tr>
<tr>
<td>Scanner – broadcast only (+FM)</td>
<td></td>
</tr>
<tr>
<td>Scanner – multiband or special</td>
<td></td>
</tr>
<tr>
<td>Visual Tuning Indicator pre Eye</td>
<td>Relates to milliamp meters, shadow indicators and neon tubes before 1936/37</td>
</tr>
<tr>
<td>Wired Wireless Receiver (RFI)</td>
<td></td>
</tr>
<tr>
<td>Wired Wireless Receiver (AF only)</td>
<td></td>
</tr>
<tr>
<td>Wired Wireless Receiver (AF or RF)</td>
<td></td>
</tr>
</tbody>
</table>

11.7.10 Power Supply field
11.7.11 Voltage field

The “Voltage:” field on the “Create New Model” page is where the power supply voltage information for the model is entered.

![Figure 11-4: New Model Page “Voltage” field](image)

**NOTE:** On the model page, the word “Volt” is automatically entered at the end of this field! Therefore, do **NOT** enter “V” or “Volts” at the end of the voltage field!

This field has been expanded to 100 characters to allow more information (such as frequencies) to be added. Please use English for non-German speaking countries (Appropriate language of market-state is also acceptable). Here are acceptable inputs for the voltage field:

a. **Simple Entry**
   - Specify voltage (and range if known) for DC power sources: **115** (or if range known **110 to 120**)
   - If the nominal voltage and range is known: **115 = 105 to 125**
   - Specify frequency and voltage (and ranges if known) for AC power sources: **60 cycles, 120** (or if ranges are known **50 to 60 cycles, 110 to 120**). It is acceptable to use “Hz” in place of “cycles”.
   - Specify voltage (and battery type if known) for battery power sources: **1.5** (or if battery type known “D” **1.5**)
   - Specify transformers when a single model number can have different transformers:
     - **Either transformer: 25 to 60 cycles, 110V or 50 to 60 cycles, 110V or 50 cycles, 220**
     - **NOTE:** When there are different model numbers for models that have different transformers, separate models should be created.

b. **Specifying Ranges, Different Sources and Transformer Taps**
   - Old style of specifying range used dash character: **110-120** but prefer using new method: **110 to 120**
   - Use semicolon character to indicate different possible settings for a single voltage source: **110; 145; 200; 240**
- For tapped transformers, specify number of taps: >2 taps: 110 to 120 (If number of taps unknown) or if number of taps known: 4 taps: 110, 145, 220, 240
- Some manufacturers (e.g., Philips) have transformers with tap ranges that join seamlessly together: 5 taps: 100 to 130, 130 to 160, 160 to 190, 190 to 220, 220 to 250

c. Specifying Multiple Power Sources
- Use and character to specify multiple power sources: 2 & 90
- If known, take into account composition of power sources: 2 & 2 x 45
- If known, take into account battery types: “AA” 2 x 1.5 & 90
  It is acceptable to add “V” after first voltage: “AA” 2V x 1.5 & 90
  Use preferred codes for battery type: A, AA, AAA, C, D or Lantern (6V with spring connections on top).
  See also Wikipedia for other battery definitions.
  Also note the following (non-preferred) equivalences:
  AAA = UM 4, AA = UM 3, C = UM 2, D = UM 1
- Specify Bias Cell if known: 1.5V (Bias Cell) & AC: 60 cycles, 110 to 120

d. Specifying Power Source Options
- Preferred method is to use “either” and “or” to specify power source options:
  Either AC: 60 cycles, 120V or DC: 12V or Batteries: “C” 2 x 1.5
- Old method used slash character to specify multiple power sources (not preferred): 60 cycles, 120/ 2 x 1.5
- Specify use of Adapter: Either AC Adapter: 60 cycles, 120V or Batteries: “D” 4 x 1.5
11.7.12 Loudspeaker Type and size fields

11.7.13 Material field

11.7.14 Shape field

11.7.15 Dimensions fields

11.7.16 Valves/Tubes & Semiconductor fields

The “Valves/Tubes” and “Semiconductors” fields on the “Create New Model” page is where the tube and semiconductor information for the model is entered.

![Image](image.png)

Figure 11-5: New Model Page “Valves/Tubes” and “Semiconductor” fields

11.7.16.1 Valves/Tubes “Number:” field

Enter the total number of tubes in this field. Please note that only certain types of special tubes should be included in the tube count as noted below.

11.7.16.1.1 Valves/Tubes to be counted

- Rectifiers
- Magic eye tuning indicators
- Neon glow tuning indicators

11.7.16.1.2 Valves/Tubes NOT to be counted

- Ballast tubes
- Voltage or Current regulators or stabilizers (Example: 0A2, VR150)
- Symbol indicators
- VFD (vacuum fluorescent display)
- LED display
- LCD display
- Plasma display
- Nixie tubes (Counting)
- Measurement tubes
- Neon indicator tubes (Tune-A-Lite, Flash-O-Graph)

11.7.16.2 Valves/Tubes & Semiconductors lineup field

The long entry field is where the tube lineup should be entered. You should list all tubes in the tube lineup, which should also include tubes that were NOT listed in the “Number” field (For
example, you SHOULD list ballast tubes here!). Transistors, diodes and semiconductors should also be listed here.

**NOTE:** After you submit the new model proposal, you may get a message stating that a certain tube or semiconductor does NOT exist in the Radio Museum database. If you get such a message, you may submit the new model proposal, but you should contact the “Tube/Semiconductor-Admin” and ask that the missing Tube or Semiconductor be added to the Radio Museum database.

11.7.16.2.1 Valves/Tubes & Semiconductors lineup field Guidelines

Please use the following guidelines when entering the tube/semiconductor lineup:

- Enter the tubes or transistors in the order starting from the antenna and going to the speaker, with the rectifier tube(s) listed last (You can usually use the tube order from the schematic or parts list)
- For radio receivers, if a “Magic Eye” or “Neon Glow” tube exists, this should be placed in the 5th position. This rule does NOT apply for other models (example: test equipment, tape recorders, TV sets, etc..).
- Diodes may be included in the tube/semiconductor lineup
- Always use uppercase letters for the tubes and semiconductors
- Always separate the tubes and semiconductors with a space and NEVER with a comma
- If alternate tubes are listed on the chassis or in the schematic and/or in the parts list, the alternate tubes should be listed with “or” between them, with “or” using only lower-case letters (For example: 6AQ8 or ECC85)
- If alternate semiconductors are listed on the chassis or in the schematic and/or in the parts list, the alternate semiconductors should be listed with “or.” between them, with “or.” using only lower-case letters (For example: OA172 or OA79)
- If a Selenium Rectifier exists, it should be listed in the tube lineup as “Selenium-Rectifier” at the end of the tube lineup
- If an unknown dry rectifier exists (Unknown selenium rectifier or semiconductor rectifier), it should be listed in the tube lineup as “Tr.Gl.”
- If there is an unknown tube, it should be listed as “unknown_Tube” in the tube lineup using lower case letters
- If there is an unknown transistor, it should be listed as “unknown_tr” in the tube lineup using lower case letters
- If there is an unknown diode, it should be listed as “unknown_diode” in the tube lineup using lower case letters
- Other examples of unknown devices are listed under “unknown” in the “Tubes+Tr” database, which can be found by searching with the word “unknown” in “Tubes+Tr”
- For transistors, when the number is high (>20) and some transistors appear more than once, a condensed list with only entry per type is acceptable to avoid creating unreadable long lists
11.7.16.3 Valves/Tubes & Semiconductors lineup field example

Here is an example of a hybrid radio that contains both tubes and transistors. This example also shows the use of both the "or" function for the tubes, and the "or." function for the transistors. The picture below is how the tube and transistor information appears in the new model proposal page:

![Figure 11-6: New Model Page “Valves/Tubes & Semiconductor” fields example](image)

Once the model is accepted, the information on the actual radio model page is shown in the picture below:

![Figure 11-7: Resulting Model Page “Valves/Tubes & Semiconductor” fields example](image)

11.7.16.4 Semiconductors “Number:” field

Enter the total number of transistors in this field. This number should contain ONLY transistors and NOT diodes or other semiconductors.

**NOTE:** Some radios used a diode connected transistor as the second detector, which in this case, the transistor should NOT be included in the semiconductor count.

Please use the following guidelines when entering the Semiconductor Number:

- If there are no transistors, enter “0” in this field
- If there are transistors but the number of transistors is unknown, then enter “-1” in this field
12 How to modify an existing radio model

12.1 Description

The

13 How to upload pdf’s

13.1 Description

The

14 How to use the forum

14.1 Description

The

15 How to use the Schematic Finder

15.1 Description

The
16 How to use the Literature Finder

16.1 Description

17 How to search for a model

17.1 Description

18 How to upload tube and tube box pictures

18.1 Description

19 How to upload tube documentation

19.1 Description

20 How to request that a tube, transistor or semiconductor be added to Radio Museum

20.1 Description

21 Administrator Sections

21.1 Model Administrators

The
21.1.1 The Model Administrator Page

21.1.2 Administration of Model Page Suggestions

21.1.3 Administration of New Model Proposals

Note here to check if the model being proposed already exists in the Radio Museum database!!

21.1.4 How to handle duplicate models

If there are 2 or more model pages that are duplicate models, then all but 1 model page are considered duplicates, or “Doublet” pages. The model page with the earliest creation date should remain the representative page for that model, and all pictures, schematics and information from the other duplicate model pages should be moved to the page with the earliest creation date. After moving and copying the data from the duplicate model pages, perform the following steps ONLY for the duplicate model pages:

a) Change the “Model Name” field to be “Doublet ID = xxxxxx”, where xxxxxx is the model page ID that has the earliest creation date.

b) Change the “Year” field to “9999/9999”

21.2 Manufacturer Administrators

The
21.3 Schematic Administrators

21.3.1 Correcting a “Wrong” Schematic Finder reference entry

If a schematic has been uploaded with an incorrect reference, this may be fixed by performing the following procedure:

1. Go to the model page where the schematic was uploaded to.
2. Select “Schematic Admin” from the “Documents” pull-down menu. The “Schematic Admin” page for the model will appear.
3. Click the “Move” link for the specific schematic that you would like to change the schematic reference of.

![Figure 21-1: Move Schematic file example](image)

*Schaltplan ersetzen (replacePNG)*

Wenn ein Schaltplan nicht zu öffnen geht liegt dies daran, dass der SchemaViewer die PNG Datei nicht verarbeiten kann. Die Ursache dürfte in beim Erstellen der PNG verwendeten Pack-Algorithmus liegen (PNG ist ein gepacktes Bitmap).

Da dieser Fehler selten ist, ist die einfachste Anhine, die PNG Datei zu ersetzen.

Dies setzt voraus, dass die neue Datei auf dem lokalen PC des Adressors vorhanden ist.

Nur der Superadmin hat Zugriff auf die auf dem RAN-Server gespeicherte PNG Datei.

1. Link *replacePNG* anklicken. Es öffnet sich ein Upload-Formular.
2. Damit die neue Datei auf dem PC selektieren
3. Mit Klick auf “Submit” wird die Datei hochgeladen.

Nach dem Upload wird wieder der Schaltplan Admin (diese Seite hier) angezeigt. Per Programm wird dabei Folgendes ausgeführt:

- Es wird die bisherige PNG Datei durch die neue Datei ersetzt
- Dabei wird der bisherige Dateiname beibehalten - ein anderer Name der hochgeladenen Datei wird ignoriert
- Es werden neue Vorschau- und Minibilder erzeugt
- In der Datenbank wird die Dateigröße aktualisiert
- In die Bild-istory wird ein Eintrag über das Ersatzen (wir / wann) gemacht.

*Alle anderen Informationen (Uploader, Datum, Verknüpfung zum Schaltplan-Finder) bleiben erhalten.*

11-11-04: Diese Info nicht direkt im Quelltext beim DM5
4. The “Move image to another model” page will appear. The schematic needs to be moved to the same model. This is done by typing in the same model ID into the “by model id” box, then click the “GO” button.

![Figure 21-2: Move Schematic to same model](image)

5. The Question “Which existing catalogue entry shall be used?” appears, along with a list of the existing references (catalogues) associated with the model. In this example, the “SAMS Photofact Volume/Set 313, Folder 1 Year 1956” catalog reference is not correct and needs to be changed to “SAMS Photofact Volume/Set 314, Folder 1 Year 1956”.

a. If the correct reference is not listed, click the “It needs a new entry!” button (See Figure 20-3). Click the “GO” button, then go to step 6.

b. If the correct reference is listed, then click the correct reference (See Figure 20-4). Click the “GO” button, then go to step 8.

![Figure 21-3: Create new reference if the correct reference is not listed](image)
6. The “Schematic upload – Source selection” page appears. Now the correct Schematic Finder reference may be entered. For this example, the “SAMS photofact” is selected in the “Establish connection” box, then “314” is entered into the “Volume/Set” box, “1” is entered for the “Page or Folder” box and “1956” is entered for the “Year” box. Next click the “Continue>>” button.

Figure 21-5: Entering a new entry for the Schematic Finder
7. The “Schematic upload – Select Model from Source” page appears. Click the “Not contained in the list above” button, then click the “Continue>>” button.

![Schematic upload - Select Model from Source](image)

Figure 21-6: Selecting Not Contained in the List Above option

8. The “Move image to another model” page appears. The schematic now has the correct Schematic Finder reference. You can see this under “Image has been moved” (See Figure 20-7).

   a. If there are no other schematic pages with this model that need the Schematic Finder reference corrected, then you are done and you can now close the window.

   b. If there are more schematics with this model that need the Schematic Finder reference corrected, then click the “to the schematic admin (actual model)” link. This takes you back to the “Schematic Admin” page. Go back to step 3 and repeat the procedure to correct the next Schematic Finder reference.

![Move image to another model](image)

Figure 21-7: Showing correct Schematic Finder reference
21.4 Picture Administrators

The

21.5 Collector Price Administrators

21.5.1 Determining if you have rights as a “Collectorprice-Admin”

You must be enabled as a “Collectorprice-Admin” by the Super User in order to perform administration work on collector prices. To see if you are enabled as a Collector Price Admin, perform the following procedure:

1. From the Radio Museum Home Page, select “Organization” from the “Community” pull-down menu on the left of the Home Page.

2. The Radio Museum Administrator Groups (List of Groups) page will appear. Click the box next to “Collectorprice-Admin”, then press the red “GO” button.

3. The Members in group “Collectorprice-Admin” page will appear. If you have been enabled as a Collector Price Admin, your name will be listed on the “Collectorprice-Admin” page.

21.5.2 Changing or deleting a price

You must have a Price Admin User Name and Password in order to modify or delete prices. Use the following procedure to change or delete a tube or model price:

1. From the Radio Museum Home Page, click the “Tubes + Tr” tab at the top of the page.

2. The “Search for tube/valve” page will appear. Click the “Tube-price-admin” under the “Administrators” section on the left of the page.


4. To edit a tube price:
   a. Find the tube you would like to modify the pricing information of from the tube price list. You can sort the list in various ways by clicking the link at the top of any of the columns. Once you find the specific price you would like to modify, click the “Edit” link in the right column.
   b. This will take you to the “Tube price – details” page. You can modify, delete or move the pricing information from this page.

5. To edit a price on a model page:
   a. Click the “Admin collector prices – Models” link at the top right of the “Newest tube prices” page.
   b. The “Newest collector prices” page will appear. Find the model you would like to modify the pricing information of from the model price list. You can sort the list in various ways by clicking the link at the top of any of the columns. Once you find the specific price you would like to modify, click the “Edit” link in the right column.
   c. This will take you to the “Collector prices” page for the model. You can modify, delete or move the pricing information from this page.
21.6 Tube/Semiconductor Administrators

The

21.7 Tube/Semiconductor Picture Administrators

The

21.8 Literature Finder Administrators

The

21.9 Museum Administrators

The

21.10 Audio Administrators

The

21.11 CMS Administrators

The

21.12 Forum Moderator Team

The